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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
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Support
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l Enter into discussions with other software customers

l Research and register for software training
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Overview of File System Viewer
File System Viewer helps you to understand if your file storage infrastructure is growing in a
managed, organized, and efficient manner. File System Viewer creates an information store about
your storage system.

By combining file, logical, and physical storage resourcemonitoring and reporting with active
SAN management, File System Viewer provides a single integrated system for managing your
entire file storage infrastructure.

Use File System Viewer to obtain detailed information about file servers and volumes across your
network. You can get summary information about your files from across your enterprise to a
specific file server or volume.

File System Viewer can help you with answering the following questions.

Overall View – Dashboard

l How do I obtain an overview of the following statistics?

n Top five file servers by scanned space

n Top 10 file extensions by size or count

n Top five file extensions

n Accessed age distribution by usage or count

l The usage is the total size of all the files with the particular extension.

l The count is the number of files with the particular extension.

Composition – Aging, Size

l Why are there files on a system that has not been accessed for more than six months?

l What is the size group distribution on various file systems?

l Dowe need hierarchical storagemanagement or a store and delete policy?

Content – Extensions

l Are file systems being used properly?

l Is theremisuse of storage space?

l If there is misused space, who are the offenders?

Consumer – Users, Ownership, Applications

l Who is using how much space?

l Is the usage planned?

Capacity – Used and Available

l What is the total available capacity?

l How much is being used?
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Chapter 1

File System Viewer does a recursive lookup on the file system and stores the information in an
embedded database. File System Viewer can scan files very quickly because File System
Viewer never opens the files.

You can use UNC shares to discover file system data from a server. To scan UNC volumes, you
must define them in a UncShares.xml file. For details, see Defining UNC Volumes on page 47.

Caveats with Using File System Viewer
Keep inmind the following when using File System Viewer:

l Themaximum number of threads File System Viewer can use is 15.

l If you do not see information for the file server, verify that the collector for the file server is
running. You can verify this by selectingConfiguration > File System Viewer. On the Scan
Schedule tab, look in the Running? column. SeeWorking with Scans and Schedules in File
System Viewer on the facing page.

l File System Viewer is able to detect duplicate files only within a storage volume. File System
Viewer cannot detect duplicate files that exist on different volumes. For example, if you have a
duplicate file on two different storage volumes, File System Viewer is not able to detect the
duplicate file.

l If you plan to have File System Viewer scan a host, make sure you have 80-120MB for each
set of onemillion files. The actual size depends on the length of the file names.

l If you want to use File System Viewer bulk import capability for non-ASCII characters
(Chinese, Japanese, Korean), the file should be created with UTF-8 encoding. Tools such as
Notepad let you specify the encoding in the “Save As” dialog.

l Reparse points (junctions) for file servers onMicrosoft Windows are scanned. For example,
assume you create a junction namedC:\DDrive that points to the root of the D drive. The
content of the D drive is available under C:\DDrive. After a scan, information on capacity and
amount used is displayed for the C drive. However, the sum of the file sizes on the C drive
also includes the junction (C:\DDrive), which points to the root of the D drive. If you do not
want to include the scanning of reparse points, see Enable the Scanning of Reparse Points on
page 34. Reparse points created using theWindows Disk Management tool are discovered as
a drive that can be scanned independently.

l A storage volume on amember node that is shared as a cluster resource is not managed
through themember node. It is available only from the cluster. The File System Viewer
scheduler user interface does not list cluster shared volumes of amember node.

Setting up File System Viewer
To obtain information about your file servers and volumes, youmust do the following:

1. Discover the host as described in “Step 1 – Discovering Your Hosts and BackupManager
Hosts” in the Installation Guide or User Guide.

2. Make File System Viewer aware of the file servers it needs to scan, as described in Adding

12
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File Servers for File System Viewer to Scan on page 14. Then, scan the file servers.

You will not see data in File System Viewer until you complete this step.

3. Create schedules for scans, as described inWorking with Scans and Schedules in File
System Viewer below.

4. Import user information as described in Importing User Information from LDAP and Active
Directory Servers on page 28.

5. Create rules for gathering file server information, as described inWorking with Rules for
Gathering File Server Information on page 34.

6. Enabling the collection of ACL data, as described in Enabling the Collection of Access
Control Entry Data Collection for Directories onWindows Servers on page 45.

You will not see data in the Trustee view until you complete this step.

Working with Scans and Schedules in File System Viewer
The File System Viewer simplifies the process of specifying file servers for scan schedules and
for working with the scan schedules. The following is the File System Viewermain page
displaying a list of file servers.

The File Servers tab displays a List of file servers from which you can choose a specific server.
You can select the following actions in the associated pull-downmenus: Select, Add Schedule,
Credentials, Scan Now, and Stop Scan.

The screen enables you to filter by operating system, file server name, or both. The screen
contains three buttons located across the upper part of the page:

l Add File Server – Adds a file server.

l Schedule Multiple File Servers –Opens a wizard to schedulemore than one file server at a
time.

l Delete – Deletes more than one file server at a time. You will see a confirmation page before
the deletion occurs.
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The screen displays a list of file servers, including name, operating system and version, and
whether a file server is part of a cluster. Associated pull-downmenus (in the Action column)
enable you to select the following actions for selected file servers:

l Add Schedule –Opens the Add Schedule wizard to enable the addition of a new File Server
Viewer schedule. Only one schedule can be added for file servers on hosts with agents prior to
6.0.

l Credentials – Starts a wizard that enables you to specify the credentials to be used for scan
volumes on the file server. This functionality is supported for CIFS shares onWindows file
servers, and all types of volumes for UNIX file servers that are supported by File Server
Viewer.

l Scan Now – Enables you to perform a “run once” scan on a selected set of volumes on a
specified file server immediately.

l Stop Scan – Stops all the File Server Viewer scans currently running on the file server, but
does not stop the schedule.

l Test Scan – Enables you to perform Test Scan functionality. The feature is not available for
file servers on virtual cluster hosts. See Performing a Test Scan on page 27.

l Delete File Server (icon) – Deletes the File Server Application created on the host and
deletes all File Server Viewer information collected on the file server.

Other tabs on the File System Viewermain screen include the following:

l Scan Schedule – Displays the screen used to set up and associate scan schedules to a
selected file server. Functions available at the Scan Schedule screen include the Start and
Stop scan buttons, Edit the schedule, and Delete (for individual file server schedule deletion
and for deleting all the selected file server schedules).

l Scan Status – Provides information about the status of themost recent scan on each of the
configured volumes.

l Report Rules – Displays the screen used to set up the rules for creating reports for specific
needs.

Adding File Servers for File System Viewer to Scan
Youmust make File System Viewer aware of file servers it needs to scan if you want to see
information from your file servers.

File System Viewer does not scan the volumes with file system of type “GPFS” on HACMP
clusters.

Cluster shared resources on file server member nodes are not displayed on the Topology tab.

File servers can only be created on hosts that have non-null as the operating system value.

To add file servers to scan:

1. Click Add File Server on the File System Viewermain page (Configuration > File System
Viewer).
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The Add File Server button displays a list of available file servers that support File System
Viewer. Data collectionmust be enabled on these file servers.

2. From the displayed list of available file servers, add file servers by selecting the check boxes
for the file servers and clickingOK.
File servers that are part of a host cluster aremarked accordingly in the Is Cluster column of
the list.

Deleting Volume Data
You can delete the file system specific data of a scanned volumes so that the volumewould be
similar to an unscanned volume. The volumewould also be removed from the scan schedule and
any report rule mappings. If all volumes in a schedule are deleted, the schedule is also deleted.

Data from volumes currently being scanned would not be deleted. You can tell if a volume is
currently being scanned because it will have a scan status of one of the following:

l Scan started

l Scan in progress

l Transferring

l File uploading

The volumewith # symbol denotes that the volumewas scanned before it was assigned as a
cluster volume through the Build Cluster. This volume data is removed because it is not shown in
any FSV page.

To delete volume data:

1. Click Configuration > File System Viewer.

2. Click the File Servers tab.

3. Click Delete Volume data.

4. Click theShow Available Volumes link if the volumes are not displayed.

5. Click theShow Filter link if the filter is not displayed.

6. In the Select OS field, select the operating system for the file server or select all to display all
file servers. The file servers meeting the criteria of the Select OS field are displayed in the
Select File Server window.

7. In the Select File Server window, select a file server. The name of the file server is displayed
in the File Server Name field.

8. Click Go. HP Storage Essentials displays the volumes on the selected file server in the pane
below.

9. Select the volumes you want to delete and click Add Selected Volumes to Delete Data.
The selected volumes are displayed in the Selected Volumes table. Volumes that are in the
Selected Volumes table are reverted to the status of an unscanned volumewhen the Finish
button is clicked.
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10. To remove a volume from the Selected Volumes table, select the volume and click Remove
Selected Volumes form Deleting Data.

11. Click Finish. Volumes in the Selected Volumes table are reverted to the status of an
unscanned volume.

Scheduling Single and Multiple Scans
You can create single scan andmultiple scan schedules for a file server. Themultiple scan
schedule feature enables you to schedule scans of different volumes at different intervals and at
different start times. However, you can add only one schedule for file servers on hosts with
agents prior to 6.0.

To begin configuring for single or multiple scans, youmust first declare the intended host a file
server, and then you use the Add Schedules wizard to create the schedules for the intended file
server.

Adding a Schedule
On the File System ViewerMain page (File Servers tab), locate the file server on which you want
to set up the scan schedule.

To add a schedule:

1. Select Add Schedule from the pull-downmenu choices (in the Action column).
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2. Select theCreate Schedulewizard, which opens and displays a screen similar to the
following:

The wizard contains two volume lists:

l Available Volumes – Shows volumes available for scheduling

l Selected Volumes – Shows volumes selected for scan

The lower part of the display contains scan schedule information (start date and time, interval for
the scan). The display also shows the number of threads, representing the number of parallel
scans to be performed for this schedule. Theminimum value for the field is 1. Start time cannot be
earlier than the current time. Thread count cannot bemore than the number of volumes.

Volumes can be selected for inclusion in a schedule by selecting the corresponding check boxes
and clicking theAdd button. This removes the selected volumes from the Available Volumes
table and adds them to the Selected Volumes table.

You can correct inadvertent selections by clicking theDelete button below the selected volumes
table. This moves the corresponding volumes from the Selected Volumes table to the Available
Volumes table.
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Each volume can be individually configured. The options for each volume in the Selected
Volumes table are:

l Volume specific exclude directory list
The default exclude directory list is based on the value of the JBOSS property
fileSrm.excludeDirectories.

Scanning of a directory in the exclude directory list skips collections if the directory exists in
the root of the volume. If a directory of the same name exists at any other level, that directory
is scanned.

l Option to collect ownership

l Option tomap users to ownership. The option is enabled only if the ownership collection is
selected.

l Option to collect ACL information forWindows file server

When a schedule is saved, changes to the properties do not affect already saved schedules. All
schedules can be viewed and edited in the Scan Schedules page.

Excluding Volumes from Scanning of File Extension Details
If you have volumes with more than twomillion files, youmight want to decrease the scanning
time by excluding volumes with many files from the scan.

File extension details are not collected for the volumes specified in the
fileSrm.volumesToSkipExtensionsGathering property; for example:

fileSrm.volumesToSkipExtensionsGathering=10000,10001

In this instance, 10000 and 10001 are volume IDs for the volumes that are designated to be
excluded. The property can be found inConfiguration > Product Health > Advanced > Default
Properties.

Skipping collection of file extensions could affect the way file extensions are displayed in the drill-
downmenus of the product. The information displayed for the file extensions on excluded
volumes could bemissing or outdated.

Credentials
You can specify or edit the credentials used by the File Server Viewer to scan volumes on the File
Server Viewer. To assign or clear credentials, select Credentials from the pull-downmenu
choices (in Action column).
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You can assign credentials, clear credentials, and edit credentials. To assign credentials to a
given set of volumes, choose the volume and select theAssign Credentials button.

You can edit or clear credentials for a UNC share volume. However, doing this on aWindows-
based system does not prevent running further successful scans on the volume. Windows allows
you to run a successful scan on that volume, even though the credentials for it were edited or
cleared.

You can assign (specify) the user name and password to use for scanning the volume.
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Enter the user name and password, and then click OK. The credentials are saved into the
database after the wizard completes.

Edit Credentials
The Edit Credentials screen enables you to change a user name and password previously
assigned.

The associated volume is shown in the header. Enter the new credentials and then select OK.

Scan Now
Select theScan Now pull-downmenu choice (Action column) to perform an immediate scan on a
given set of volumes. The wizard and functionality are similar to configuring an interval-based
scan, except that the start time and interval are not required.

20



Overview of File System Viewer

The@ symbol appended to the drive name indicates that the volume is scheduled for a scan in an
interval schedule. The Thread Count feature enables you to specify the number of parallel scans
to be run in the schedule.

The Scan Now option creates a “run once” schedule, which is not stored for future use. Exercise
caution when using the Scan Now option, because a scheduled scan could already be in process
at the instant that a forced scan is invoked. In such a situation, the volumes being scanned, or the
volumes currently in the scan queue, are omitted from the new scan request.

Schedule for Multiple File Servers (Multiple Scans)
The ScheduleMultiple File Servers button on themain FSRM display page, File Servers tab,
provides functionality similar to the Add Schedule button. It also provides the additional capability
to createmultiple schedules across multiple file servers. Selecting the button starts a wizard
which contains two tabs, Available Volumes and Selected Volumes.
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The filter enables you to narrow the list of file servers displayed. After filtering, the File Servers list
shows the list of file servers available for scheduling. Use the corresponding radio buttons to
populate the list of volumes available for scheduling (Storage Volumes table).

Multiple volumes can be selected and configured from the table to be added in the schedule. After
the configuration is finished, select theAdd button to confirm the number of volumes selected for
the schedule.

You can repeat the previous steps for other file servers in the File Servers table, or you can filter
new file servers. After you add the volumes for the file servers, select theNext button to open the
Selected Volumes tab display.
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The display shows the volumes added for the various file servers in the Available Volumes tab.
The Selected Volumes tab display does not permit editing volumes. To edit configurations, or
remove volumes, select thePrev button to go back andmake the changes.

The Selected Volumes tab displays the date and time, the interval, and the thread count for the
schedules created. After you assign the required values, select the Finish button to create
schedules for themultiple file servers.

The wizard helps you createmultiple schedules at the same time. Once submitted, schedules are
created for each file server that was configured.

The thread count for the schedule created is computed with the following formula:

Thread Count = minimum (Number of Volumes Selected, value in Thread

Count field)

Warning and Alert for Deleted Volumes
When you select drives for a particular host, they show as selected (on the Configuration File
Viewer page) for a period of time (one day, 12 hours, etc.). When the drives no longer display as
selected after that period of time, a warning icon appears for those schedules that are partially or
fully affected.

When you click the warning icon, an alert message appears. Themessage content depends on
whether the volumes are partially or fully affected. Message contents are the following:

l All volumes affected – Assume a schedule contains five volumes and are all deleted in the
database. If you click on the warning icon that appears, an alert message similar to the
following appears:
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Storage volumes scheduled for a scan in this task either do not

exist now, or have changed in the database. These volumes cannot be

scanned now. Please click the Delete icon to delete them and create

a new schedule.

l Some volumes affected – Assume a schedule contains five volumes and only some of them
are deleted in the database. If you click the warning icon that appears, then an alert message
similar to the following appears:

Some Storage volumes scheduled for a scan in this task either do

not exist now, or have changed in the database. These volumes

cannot be scanned now. Please click the Edit icon to include them

for a scan.

Scan Schedules Tab
The Scan Schedules Tab on the File System Viewermain page lists all the schedules created for
the various file servers:

TheStart andStop buttons near themiddle of the screen, at the right, can be used as batch
operations to start or stop the selectedmultiple schedules. TheDelete button can be used as a
batch operation to delete selectedmultiple schedules.

Each schedule lists the file server, volumes selected for scan on the file server, the time the
schedule is invoked next, the interval in minutes, and its status (running or stopped). The display
also contains the following:

l Stop Scan – This button attempts to stop the scan on the volumes selected in the schedule. It
does not stop the schedule and the schedule can run at the next interval. If you want to disable
a schedule, select the Stop button (at the top of the page) after selecting the schedule to be
disabled.

l Delete Schedule icon – Select this icon to delete the schedule. It stops the scan on the
volumes selected for the schedule before the deletion. However, this does not alter any File
Server Viewer data already collected for the volumes in the schedule.
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l Edit icon – This starts the Edit wizard, letting youmodify the schedule to change the volume
list or its other scan options. Edit is described further in the following paragraphs.

Editing a Scan Schedule

The Edit button enables you to change the scan configuration by changing the volume list for the
scan, changing the start time (next scheduled time to run if one is already started), interval, and
thread count. You can also change volume specific information, such as ownership collection,
mapping users to ownership, exclude directory list, and ACL collection for theWindows file
server.

Clicking the Edit icon starts a wizard. The screen contains two tabs, Available Volumes and
Selected Volumes.
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This screen enables you to select volumes available for further addition to the schedule by
checking the corresponding check box. You can alsomodify the default configuration information
for each volume. After making your selections, select theAdd button to confirm your intent to add
them to the schedule.

TheAdd button does not add the volumes to the schedule yet; it only confirms they are
considered for addition.

After selecting theAdd button, select theNext button to open theSelected Volumes tab.

This display provides a list of volumes for this schedule. You can remove volumes by selecting
theRemove button.

Theremust be at least one volume in the Selected Volumes tab. You cannot delete the schedule
by simply removing all the volumes from the Select Volumes tab. If you attempt to do so, an alert
is raised.

Scan Status Tab
You can review the status of the current scan or themost recent scan that took place on each of
the volumes on which a scan was started.

To check the status of a scan:
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1. Select Configuration > File System Viewer.

2. Click theScan Status tab.

The following table provides details about the Scan Status tab.

Column
Heading Description

File Server Displays the name of the file server from which this collector gathers
information.

Volume Displays the volume selected for scanning on a file server.

Scan Start Displays the time that the scan began.

Last Polled If the scan is still in progress or failed, it displays the time of the last
scan.

Scan End If the scan is completed, displays the completion time.

Scanned Space Displays the total size of the files scanned by File System Viewer.

No. Of Files Displays the number of files that have been scanned.

Current
Directory

Displays the directory that is currently being scanned.

Scan Status The following scan statuses are possible:

l NoData

l Scan in Progress

l Scan Done

l Scan Failed

l Transferring Data

l Transfer Completed

l Uploading Data

l Uploading Completed

l Error

Performing a Test Scan
If you changed your network configuration and are not sure themanagement server can still scan
the server running File System Viewer, you can perform a test File System Viewer scan. During
this scan, themanagement server verifies that it can access the server and perform a high-level
File System Viewer scan. It also verifies whether or not it can scan network volumes with host
discovery credentials.
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Keep inmind the following:

l This feature only works with CIM extensions version 5.1 and later.

l To scan network-mounted drives on a host runningWindows, sure a user is logged onto the
Windows host. The user must have permission tomount the network drives. Network drives
mounted onWindows 2000 hosts are not visible as storage volumes on the Navigation tab or
in the topology.

To perform a test File System Viewer scan:

1. Select Configuration > File System Viewer.

2. Verify that the File Servers tab is selected, and then click Test in the Test Scan column of the
File Servers table.

After you click the Test button, themanagement server attempts to access the server and
perform a test File System Viewer scan.

Importing User Information from LDAP and Active
Directory Servers

You can enable the automatic population of user details from Active Directory and/or Light weight
direct access protocol (LDAP) servers, so at least the following information is retrieved from
directory services:

l User Name

l Full Name

l Email ID

l Department Number

l User Quota

l User Status* – for example, Active or Disabled

l Manager*

l HomeDirectory

l Owner

*The User Status andManager columns are populated when information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

HP Storage Essentials enables you to import user data from two types of servers:

l Exchange servers – If you already discovered Exchange servers, you can select the servers
from which HP Storage Essentials will import user data. Exchange servers are considered as
LDAP servers in the LDAP Users Collection table.
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l LDAP servers – Discover LDAP servers from which you want HP Storage Essentials to
import user data.

You can specify how often user information from the servers listed in the LDAP Users Collection
table is updated.

LDAP Users Collection Table

The LDAP Users Collection table lists the servers that are designated to be scanned by HP
Storage Essentials for user data. The table provides the following information about an LDAP
server:

l Domain – The domain in which the LDAP server resides

l Domain controller name – The name of the controller name for the LDAP server

l Next Scheduled Run –WhenHP Storage Essentials will scan the LDAP server again for
updated user information

l Interval in Minutes – How often the scan is scheduled to run

l Enabled – Checked if collectors are running. Collectors must be running for a scan to run.

l Collection status – Lets you know if a scan is currently taking place or if the scan is
complete.

You can also do the following:

l Edit discovery information for an LDAP server.

l Edit the scan schedule for an LDAP server.

l Delete an LDAP server from the table. When an LDAP server is deleted from the table, HP
Storage Essentials no longer scans the LDAP server for user information.

Importing User Information from a Discovered Exchange Domain Server
To import user data from a previously discovered Exchange Domain Server:

1. Select Configure > File System Viewer > LDAP Servers and click Add Active Directory
Domain Controller(s).

2. Select the discovered Exchange Domain Server that contans the user data you want to
appear in HP Storage Essentials.

3. Click Add andOK. The Exchange Domain server is designated as an LDAP server.

Importing User Information from LDAP Servers
To import user data from LDAP servers:

1. Select Configure > File System Viewer > LDAP Servers and click Add LDAP Servers.

2. Expand the link, Add New LDAP Server.
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3. Select the discovered LDAP that contans the user data you want to appear in HP Storage
Essentials.

4. Provide the name of the domain in the Domain field.

5. Provide the name of the domain controller in the Domain Controller Name field.

6. Provide user name in the User Name field.

The user name can be the common name (CN) of the user or theWindows login name. You
can find the CN from the Active Directory Users and Computers plug-in. The user must
possess aminimum of “Domain Users” privileges.

7. Provide the password for the User name in the Domain Password field.

8. Provide the password again in the Verify Password field.

9. Click Add, and then click OK.

Modifying the Collection Schedule for LDAP Servers
Tomodify how often user information is gathered an LDAP server:

1. Select Configure > File System Viewer > LDAP Servers.

2. Select the LDAP server for which you want to modify the schedule.

3. Click theEdit Schedule ( ) button.

4. Click the calendar icon, .

5. In the Time box, enter the time in 24-hour format with the hour andminutes separate by a
colon; for example, 22:15. Click the date on which you want the task to run. Today’s date is
highlighted in pink. Click Set.

The date and time appear in the Next Scheduled Run box in the yyyy-mm-dd hh:min format.

If you change the date in the box to a date that does not exist in amonth, the software
automatically calculates the date to the next month. For example, if you enter 2010-11-31,
the software assumes the date is 2010-12-01.

6. In the Interval box, enter an interval. Select one of the following units from the list:

n Second(s)

n Minute(s)

n Hour(s)

n Day(s)

n Week(s)

7. Click OK.

Editing Discovery Information of LDAP Servers
To edit discovery of LDAP servers:
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1. Select Configure > File System Viewer > LDAP Servers.

2. Select the LDAP server you want to edit and its correspondingEdit ( ) button.

3. Modify the user name and password.

4. Click OK and then click OK again. The product imports user data from the LDAP server.

About Reports for File System Viewer
Report Optimizer provides a variety of detailed reports for file servers.

Data collectors gather information for reports. If you stop a data collector, its reports are not
updated. Youmight want to verify that a collector is running if you are having difficulty viewing a
report or you believe the report is not displaying the latest information. See the user guide for more
information.

You can configure File Server SRM to gather specific information by adding rules, deleting rules,
editing rules, andmapping volumes to the rules.

You can createmultiple schedules for a single file server, and add and remove volumes to
schedules. A schedule cannot contain volumes (details) for more than one file server, but each file
server can havemore than one schedule.

After a successful file server scan, the upload process starts. During this time, extensions, aging
and size groups, and other details are collected. After that, the File Server SRM custom report
data collection begins.

The first part of the process enumerates all rules for the given volume. The process then executes
according to the rules specified.

The reporter reads the results to display the information according to the display criteria specified.

Themanagement server provides reports that display performance information in a variety of
formats:

l HTML (default) – The software displays the report in aWeb page by default.

l PDF – The software displays the report in Adobe Acrobat, a good option if you need to print the
report. The software assumes you already have Adobe Acrobat Reader installed on your
computer. To obtain a copy of Adobe Acrobat Reader, go to http://www.adobe.com.

l Excel – The software displays the report in Microsoft Excel, providing you have a copy of
Microsoft Excel already installed.

l XML – The software displays the report in the XML format.

Reports could bemade of files not accessed in the past n years, files with specific file
extensions, files that exceed a given size, and so on. For example, File Server SRM can group
the file extensions into different categories, so that users can generate reports for the different
applications, such as office-related files (*.doc, *.ppt, *.xls) or music-related files (*.mp3, *.avi).
Supported reports can be used by external reporting tools.
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Report information can be filtered. UNIX Global Permissions allows users to filter files into the
report according to rwx permissions. Files with other permissions are present in the report if they
satisfy the selection. For example, the report corresponding to global write permission could
contain files with global execute permission, provided the files also have the global write
permission.

TheWindows Attributes option enables users to filter files into the report according to a selected
set of attributes. Only the files that have the selected attributes are collected against the rule
(irrespective of the state of the other attributes). For example, selecting Archive and Encrypted
attributes filters all files that have these attributes. Some of the files in the report might contain
files of other attributes (that is, Hidden), if they have the archive and encrypted attributes.

Non-ANSI text—for example, Asian characters and the Euro symbol—included in a comma-
separated values file is not displayed properly by Microsoft Excel. Excel replaces the non-ANSI
text with a questionmark (?).

Creating Policies for File System Viewer Users
You can create a utilization policy that generates an event, sends an email, or runs a custom
commandwhen an element is being overused. For example, you can configure Policy Manager so
you receive an email message when the amount of free space on a server decreases to a
specified level.

If you plan to use email notification with your policy, first assign an SMTP server from which the
management server can send its email notifications.

To create a utilization policy for a file server:

1. Access Policy Manager by clicking the Policy Manager icon in the left pane.

2. Expand the Policy Manager tree so it displays File Server Users and the users beneath the
node.

3. Do one of the following:

n To apply the policy to all File System Viewer users, select the File Server Users node.

n To apply the policy to only one File System Viewer user, select that user.

4. In the right pane, select Add.

5. Select a policy, and then select Next.

6. In the Name box on the Policy Properties tab, modify the name of the policy or keep the
default.

7. In the Description box, modify the description for the policy or keep the default.

8. In the Re-arm Period box, specify a re-arm period in minutes.

The re-arm period is the amount of time after the policy executes before it can execute again.
It is useful for limiting the number of times the same actions will execute.

You can specify shorter periods for important applications.
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9. To the right of the comparison operator menu, enter a percentage or an amount in gigabytes
(GB), depending on the box name displayed.

10. For trending policies, enter the number of days in the Historic period box (min=7; max=180)
and Projection period box (min=1; max=180).

11. Select an action to occur when the policy condition is fulfilled by selecting one or more of the
following buttons (more than one action can be assigned to a policy):

n Send E-mail – Policy Manager sends an email when the condition is fulfilled.

Enter a comma-separated list of email addresses, and then select OK.

n Generate Event – Policy Managergenerates an event of the specified event type. The
event appears in Event Manager.

Select one of the following event types:

o Unknown – The severity level is not known.

o Informational – An example of an informational event is a progress report event for
firmware download operation currently in progress.

o Warning – An example of a warning is when one or more new physical fabric objects
(device port, switch, or fabric) have appeared.

o Minor – An example of aminor event is when a physical fabric object (switch port or
fabric) has changed state.

o Major – An example of amajor event is when one or more physical fabric objects
(device port, switch, or fabric) have disappeared.

o Critical – An example of a critical event is Brocade switches that have a failed
firmware download and the failure reason code for each respective switch.

Because the severity level for an element is set by themanufacturer, themeanings of the
severity levels vary. It is best to view the description of the event.

After you select an event level, select OK.

12. Execute a Custom Command – Policy Manager executes a custom command on the
management server when the condition is fulfilled. Enter a command that will execute the
script in the box, and then select OK.

The software assumes you are in the [Install_
Dir]\JBossandJetty\server\appiq\remotescripts directory on themanagement
server when the script is executed. You can use environment variables in your script, such
as POLICY_NAME and POLICY_DESCRIPTION. POLICY_NAME provides the policy
name and POLICY_DESCRIPTION provides the policy description. See “Software
Environment Variables for Scripting” in theUser Guide.
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Prefix the commandwith start if the custom command triggers a UI component, such as a
program that uses the UI (such as Microsoft Internet Explorer) or a command prompt
window. For example, assume you want the custom command to open a command prompt
window and list the contents in the directory. You would create the following command:

start dir

13. Select Finish.

14. To test a policy, select the Test button in the Utilization Policy table.

For more information about editing, deleting, and emailing policies, see theUser Guide.

Enable the Scanning of Reparse Points
Reparse points (junctions) for file servers onMicrosoft Windows are scanned. For example,
assume you create a junction namedC:\DDrive that points to the root of the D drive. The content
of the D drive is available under C:\DDrive. After a scan, information on capacity and amount
used is displayed for the C drive; however, the sum of the file sizes on the C drive also includes
the junction (C:\DDrive), which points to the root of the D drive.

To enable the scanning of reparse points onWindows file servers:

1. Select Configuration > Product Health, and then select Advanced in the Disk Space tree.

2. Select Show Default Properties at the bottom of the page.

3. Copy the fileSrm.disableReparsePointsScan property. How you copy the text depends on
yourWeb browser. If you are usingMicrosoft Explorer or Netscape Navigator, select the
text, right-click the selected text, and then select Copy.

4. Return to the Advanced page (Configuration > Product Health) and select Advanced in
the Disk Space tree).

5. Paste the copied text into the Custom Properties box. How you paste the text depends on
yourWeb browser. If you are usingMicrosoft Explorer or Netscape Navigator, right-click the
box and select Paste.

6. Change the value assigned to the fileSrm.disableReparsePointsScan property to false in the
Custom Properties box.

fileSrm.disableReparsePointsScan=false

7. When you are done, select Save.

8. Restart the AppStorManager service for your changes to take effect.

Working with Rules for Gathering File Server Information
You can create specific rules for the kind of information the system gathers and reports about file
server volumes and directories (rule-based reporting). You do this by adding, deleting, and
assigning rules to selected file server volumes and directories. In addition, you can edit previously
created rules to accommodate changing reporting needs.
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The Report Rules tab in the File System Viewer (Configuration > File System Viewer) provides
the user interface and wizards to create andmodify these rules.

Using the buttons and check boxes on this screen, you can Add, Delete, and Edit rules,
Add/Remove volumes associated with the rules, Refresh File Server Reports Cache, and Clear
Data.

Data collected for the rules is reflected in reports according to the reports refresh schedule. The
Refresh File Server Cache button refreshes the reports cache immediately with data acquired
using latest rules for gathering the data.

The Clear Data button deletes the data collected against a Rule. Clearing the data for a Rule, then
refreshing the reports cache using the Refresh File Server Reports Cache button also removes
the rule’s earlier data from the reports cache.

Add/Remove Volumes
The Add/Remove volumes icon starts a wizard that enables you tomap volumes to rules (or
remove them). The wizard has two tabs, Available Volumes and Selected Volumes.
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From the Available Volumes tab display, use the Filter button to display a list of file servers.
Select the radio buttons to select the volumes from those available for mapping the rules. After
making your selections, click theAdd button to confirm the choices selected. You can repeat the
process for other file servers in the table, or click the Filter button to populate a new list.

Select theNext button to open the Selected Volumes tab.
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This wizard helps youmap volumes onmultiple file servers at the same time. To edit your
selections, select thePrev button. When you are finished, select the Finish button tomap
volumes to a rule, or select theRemove button to remove them.

Create Rule Wizard
The Create Rule wizard helps you create report rules for files. The Create Rule wizard opens a
page similar to the following.

To create rules for files, use the radio buttons to select the files or directories to which the rules
will be applied. Keep inmind the following:

l Select corresponding check boxes to include the criteria in the rule.

l Rule name is mandatory.

l Select the appropriate text box before entering a value; otherwise, text box is disabled.
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l By default, all check boxes are unchecked.

l A description is optional.

l Select at least one check box in addition to RULENAME and Limit Rows.

l Maximum valuemust be greater than theminimum value; for example, File Size >=5 and <=4
is invalid.

l In the “Owned by” text field, you can set single user or multiple users, separated by commas.

l In the “Include directories” text field, you can set single directory or multiple directories,
separated by commas.

l Enter a value in the “Limit Rows” field to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule could return a very large number of rows. If no value is entered,
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

l Drop-down choices for sizes shows units for bytes, KB, MB, andGB. Themaximum number
of digits allowed is five.

l Drop-down choices for days shows units for days, weeks, months, and years. Themaximum
number of digits allowed is five. The field accepts amaximum of 43,800 days (120 years) only
after converting the units (weeks, months, years) into days.

l Windows Attributes only affects Windows file servers even if a Report Rule is mapped to a
UNIX-type file server.

l UNIX Global Permissions only affects UNIX-type servers even if a Report Rule is mapped to
Windows file servers.

l When you select OK, the rule is created for all the fields whose check boxes are selected. At
the time of information gathering, the associated rules are applied to the gathering process to
collect the data prescribed by the rule, and to store the data in the database.

Edit Rule

The Edit wizard enables you to edit rules by modifying the Rule criteria. When you start the Edit
wizard, a screen similar to the following is displayed.
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The Rule Name value is disabled. You cannot change the rule name for any report.

The “Apply this rule to” radio buttons are disabled. You cannot change the Files, Duplicate Files,
or Directories rule types.

The Create Rules requirements also apply to the Edit Rule screen.

Create Rule (for Directories)

The Create Rule (for Directories) wizard helps you create rules for reporting about directories.

Start by selecting theCreate Rule button in the Report Rules Tab screen display. This opens the
Create File Server Report Rule page, where youmust select theDirectories radio button.
Selecting the Directories radio button displays a screen similar to the following.
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The screen displays the input fields for creating the Rule criteria for Directories. The criteria
includes Last Accessed time interval (days, weeks, months, years) and Last Modified time
interval.

Enter the Access and Last Modified Days criteria. Reports will be generated for directories that
were accessed greater than the Access days value, and greater than the Last Modified days
value.

Provide input to the screen according to the following rules:

l Rule name is mandatory.

l At least one checkbox must be selected in addition to the Limit Rows, and the respective input
box must be filled.

l The description is optional.

l Enter a value in the “Limit Rows” field to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule could return a very large number of rows. If no value is entered,
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

l The drop-down for days shows units for days, weeks, months, and years. You can enter a
maximum of 5 digits. Input accepts amaximum of 43800 days (120 years) only after
converting the units (weeks, months, years) into days.

l When you select OK, the rule is created for all the fields whose check boxes are selected.

Edit Rule (for Directories)

The Edit Rule (for Directories) screen enables you to change the access andmodified days
values.
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The Rule Name value is disabled. You cannot change the rule name for any report.

The “Apply this rule to” radio buttons are also disabled. You cannot change the Files, Duplicate
Files,or Directories rule types.

The criteria for the other remaining entries are the same as described previously for creating a rule
for Directories.

Duplicate Files
The system takes various inputs (match file size, matchmodified time stamp and directory) that
are used as criteria to collect the duplicate files, and then generates a rule that you canmap to any
volume across file servers. When the system gathers information, it applies the rules that exist for
the particular volumes, and then collects the data and stores them in the database. Add Rule (for
Duplicate Files) below.

Add Rule (for Duplicate Files)

Start by selecting theCreate Rule button in the Report Rules Tab screen display. This opens the
Create File Server Report Rule page, where youmust select theDuplicate Files radio button.
Selecting the Duplicate Files radio button displays a screen similar to the following.
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Rules for this screen are:

l Rule name is mandatory.

l In the “Include directories” text field, set single or multiple directories separated by commas.

l Enter a value in the “Limit Rows” field, to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule could return a very large number of rows. If no value is entered,
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

l The description is optional.

l When you select OK, the rule is created based on the selected check boxes.

Edit Rule (for Duplicate Files)

The Edit Rule screen enables you to edit the rule by changing the Rule Criteria and description.
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The Rule Name value is disabled. You cannot change the rule name for any report.

The “Apply this rule to” radio buttons are also disabled. You cannot change the Files, Duplicate
Files, or Directories rule types.

The remaining criteria to enter are the same as described previously to create a rule for duplicate
files.

Enabling Rules
To enable the rules, use the screen displayed with the Report Rules tab.

Using Enable Rule feature, you can enable the rules which are currently in disabled state. On
enabling a rule the system gathers data, based on the conditions specified in the rule, for the
volumes to which the rule is mapped with.

Note: By default, all the rules created in the system are in enabled state.

To enable, select the rules and click Enable Rule(s) button.

Disabling Rules
To disable the rules, use the screen displayed with the Report Rules tab.
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Using Disable Rule feature, you can disable the configured rules without deleting them from the
system. All the disabled rules are ignored during gathering of the data for the volumes they are
mapped with. Disabling rules also results in faster scanning of volumes, as the system does not
filter the data based on conditions specified in the rule.

To disable, select the rules and then click Disable Rule(s) button.

Deleting Rules
To delete rules, use the screen displayed with the Report Rules tab. The following is a
representative screen display.

You can select theDelete button to delete multiple rules (those with checked boxes next to the
rule name), or you can delete individual rules using the Delete icon for the specific rule.

The result of removing (deleting) rules depends on whether or not the rule is mapped to a volume,
and whether data was collected for that rule.

l If you remove a rule that is not mapped to a volume, the rule is deleted directly.

l If you remove a rule that is mapped to a volume AND the data is not collected, the system
deletes both the rule and themapping data.

l If you remove a rule that is mapped to a volume AND the data is collected, the system deletes
the rule, themapped data, and also the collected data (report).

l When you select theClear Now button, the system clears the data related to the rule.

Viewing Results in Report Tree
When the system gathers data for a volume, it checks to see if any rules aremapped to that
volume. If rules aremapped to that volume, the system collects the data according to the
parameters defined in the rule and stores this information in the data tables. The collected
information can then be viewed from the Reporter tree (Reporter > System > File Server).

Sometimes the File System Viewer report datamight not be visible immediately after the rule
executes because the report's cache has not yet been updated. To refresh the File System
Viewer-related report cache data, select theRefresh FSRM Reports Cache Now button. The
button is on the Custom Reports tab screen, and is located next to theAdd andDelete buttons in
the upper right part of the screen.
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Enabling the Collection of Access Control Entry Data
Collection for Directories on Windows Servers

Access Control Entries for directories can be collected onWindows file servers. Youmust enable
the collection of Access Control Entry Data to view information in the Trustee view.

To enable the collection of Access Control Entry Data:

1. Change the global property fileSrm.collectACL from false to true:

a. Click Configuration > Product Health.

b. Select Advanced from the Disk Space tree.

c. Change the value of fileSrm.collectACL from false to true by pasting the
following in the Custom Properties field:

fileSrm.collectACL=true

d. Click Save.

e. Restart the service for HP Storage Essentials, AppStorManager.

2. Select the Collect ACL option for a scan of a volume on aWindows server:

a. Click Configuration > File System Viewer.

b. On the File Server tab, selectWindows in the Select OS Typemenu and click Filter.

c. Click Add Schedule.

d. In the top pane, select the storage volumes you want to add and click Add.

e. In the lower pane, select the Collect ACL option. You can select the option for specific
volumes or for all of the volumes at once. The following example shows the Collect
ACL option being selected for all of the volumes on a file server by selecting the option
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in the heading.

3. Click OK.

4. Select Scan Now.

HP Storage Essentials starts gathering ACL data. To view the ACL data for all of your file
servers, access the Trustee view, as described in Trustee View on page 73.

When the collection option is enabled, the file scan process collects each directory’s
Discretionary ACL information, governed by the following considerations:

l The process collects only the information allowed by the access rules and ignores the
information denied by the access rules.

l The process considers allowing access based upon all the related rules, whether directly
assigned on the directory or whether they are inherited from one of the parent directories.

l The trustees corresponding to theWell Known SIDs as defined by Microsoft
(http://Support.microsoft.com/kb/243330) are excluded from being listed in the output.

l The effective permissions for each trustee are designated as Full Access, Write Access, or
Read Access.

n Write Access is the combination of the rights: List Directory, Traverse Directory, Add File,
Add Subdirectory, Write Directory, Traverse Directory, Read Attributes, and Read
Permissions.

n Read Access is a combination of rights: List Directory, Traverse Directory, Read
Attributes, and Read Permissions.

n Full Access is the combination of rights as defined by “Full Control by Windows.”

l Data Collection treatment is similar for both individual users and groups, that is, groups are not
drilled down to get a list of individual users.
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l The collection attempts to get the name of the various security entries from the corresponding
security ID (SID). The name resolution from the SID could fail if the SID is from a different host
or domain from the file server through which the file system is being scanned. In such cases,
the SID itself is listed as the trustee instead of the name.

l The collected data is sent to a file on the disk along with other scan data files. The data file
created by the process is then transferred to themanagement server along with other scan
files. On themanagement server, the data is parsed to extract the effective usage by each
trustee.

The process can have a performance impact during the scan. If the Access Control Lists are
extracted, the scan times can be larger than they would be otherwise.

About the FileSRMProvider.properties File
The FileSRMProvider.properties file resides in the conf directory of installed CIM Extensions. It
contains the following properties:

l com.appiq.fsrm.dataDir – Defines the directory in which FSRM data and log files are written.
The default is the <CIM EXTN root>/xData directory. If there is an error with the directory
specified, the default directory is used. When you change the property, youmust restart the
CIM extension for the new value to take effect.

l com.appiq.fsrm.chunkSize – Defines the chunk size (in KB) used to transfer FSRM data to
themanagement server. Typically, it does not needmodification by the user.

l com.appiq.fsrm.StatusPollInterval – Defines how often (in seconds) themanagement
server retrieves the state of the current scan from the native FSRM process. The default
interval is 60 seconds. Increasing the frequency of status polling (decreasing the polling
interval) could increase the length of time required by the scan.

Defining UNC Volumes
You can use UNC shares to discover file system data from a server. To scan UNC volumes, you
must define them in a UncShares.xml file.

To create the UncShares.xml file on aWindows host:

1. Confirm that a CIM extension is installed on theWindows host.

2. Go to the <Installation_Directory>\CimExtensions\conf directory.

3. Open the UncShares.xml-sample file in a text editor.

4. Identify the host through which the UNC shares’ scan is planned. This is the host through
which you will be scanning UNC shares from a different/remote host.

5. Add the host name and shared directory to the following line:

<!-- <UNC_SHARE PATH=""/> -->

Here is an example:
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<UNC_SHARE PATH="\\RemoteSystem\MyShare1"/>

In this instance, RemoteSystem is the name of the host andMyShare is the name of the
shared directory.

Repeat for all your shares; for example:

<UNC_SHARE PATH="\\RemoteSystem\MyShare1"/>

<UNC_SHARE PATH="\\RemoteSystem\MyShare2"/>

<UNC_SHARE PATH="\\RemoteSystem\MyShare3"/>

6. Save the file as UncShares.xml.

7. Restart the CIM Extension service on themanaged host.

8. Update the element details for the host from themanagement server by running aGet
Details.

9. Edit the File System Viewer configuration page for the host selecting the desired UNC
shares to scan.

The username and password combination you used for discovering the host should have at least
read only permissions on the file shares that need to be scanned. In most cases, this would be a
service account that you can have created in the active directory. This service account should be
an admin on the proxy FSV host and should have read only (at least) access to the UNC share.

You can use the IP address of the host instead of the name.

With management server versions earlier than 6.0, to discover multiple UNC shares that have
different credentials, youmust use different proxy FSV hosts. This is because for these earlier
versions, you can use only use one login / password pair. Each UNC share has its own
associated login / password.

For management server version 6.0 and later, this restriction does not exist. You can specify
different credentials for each UNC Share or volume by using theCredentials option.

Known Issues
l Limitation of File Server Users in Policy Manager with Firefox. Firefox 3.5.3 (and likely other

versions of Firefox) will not load the Policy Manager tree if there is a large number of File
Server Users to be shown. Internet Explorer is able to load the Policy Manager tree under
these conditions.

l File Manager Exclude Directory might not Contain the Underscore. Scanning file detail
information fails if the custom property fileSrm.excludeDirectories is set to a value that
contains the underscore (“_”) character.

l File System Viewer Event “Starting transfer of data file” is Not Sent. The “Starting transfer of
data file” event from File System Viewer usually seen in the Event Manager is not sent. You
will not be able to trigger a Policy using this event.
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l Start File Manager Scan only after the Host Scan has Completed. It is possible to attempt to
start a File System scan before a scan of the host has been completed. The File System scan
will not run. Wait until the host has been completely scanned before attempting to start a File
System scan to gather file detail data.

l Directory Accessed/Modified Rules and Unix File Servers. An artifact of the Unix operating
system changes the Accessed andModified dates for directories on Unix file servers when the
directories are scanned by File System Viewer. Therefore, a File System Viewer Report Rule
that specifies either the directory Accessed or Modified date will appear not to function
properly.
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2 Viewing File System Information Across
the Enterprise

Use File System Viewer to obtained detailed information about the file servers enterprise wide, a
specific file server or volumes.

File System Viewer displays information from file servers in views, which are accessible by

clicking File System Viewer ( ) in the left pane and then setting a context, as described in
Setting a Context below.

File servers and their hosts must be in the same organization for File System Viewer to work
properly.

This section consists of the following topics:

l Setting a Context below

l Saving a View on next page

l Dashboard Information for the Enterprise on page 53

l Properties of the File Servers on page 55

l Extension View on page 56

l Providing Expressions for the Filter Fields on page 56

l Viewing Extension Groups on page 57

l Aging View for the Enterprise Context on page 58

l Sizes View for the Enterprise Context on page 59

l Managing Users on a File Server - Properties of Users on page 62

l Policies for a User on page 69

l Viewing Security and User Identifiers for All File Servers on page 72

l Trustee View on page 73

l Scan Status on page 76

l Scan Schedule on page 76

l Viewing Attribute Details on page 77

Setting a Context
If you do not see any file servers listed, verify that you have set up File System Viewer, as
described in Setting up File System Viewer on page 12.
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Use the Set Context feature in File System Viewer to specify which elements you want File
System Viewer to scan.

To set a context for File System Viewer:

1. Select one of the following:

n Enterprise: All file servers or elements are included in the scan.

n File Server: All file servers, selected file servers or only one file server is selected in the
scan.

n Volume: All volumes, selected volumes or only one volume is selected in the scan.

If you selected:

n Enterprise, see step 2.

n File Server, follow these steps in order:

i. Select all or one of the operating systems from the Select OS Typemenu.

ii. (Optional) Enter all or part of a file servers name in the Filter by File Server Name
field. Wild cards (*) are accepted. For example, if you want to scan all file servers
that begin with California, you would enter the following: California*

iii. Select file servers from the Select File Server field.

n Volume, follow these steps in order:

i. Select all or one of the operating systems from the Select OS Typemenu.

ii. Enter all or part of a file servers name in the Filter by VolumeName field. Wild
cards (*) are accepted. For example, if you want to scan all volumes that begin
with Sacramento, you would enter the following: Sacramento*

iii. Select file servers from the Select Volume field.

2. Click Go. File System Viewer scans the specified elements and provides the information in
the lower half of the page.

To reset the context to Enterprise, click theReset button.

3. Select the view you want.

Saving a View
File System Viewer enables you to save a view, so you can quickly access the information again
without selecting a context.

For example, assume you have a volume that periodically fills up with data. You could save the
Sizes view for a volume so you can quickly access the view again to determine if the space is
being taken up by several very large files or many small files.

To save a view:
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1. Select a context as described in Setting a Context on page 51.

2. Select a view.

3. Click Save View.

4. Provide a name for the view.

If you are saving the name of a view that includes information about a file server or volume,
include the name of the file server and/or volume as well as the name of the view.

File System Viewer saves the view in theMy Views table:

Wait for the current page to complete loading before clicking a saved view in theMy Views table;
otherwise, youmight see an error when you click a saved view.

Dashboard Information for the Enterprise
The dashboard page of themanagement server provides an overview of the status of all file
servers in your network. The dashboard provides the following four panes.

As the file sizes grow, the units switch frommegabytes to gigabytes.

Summary

l A graph displaying the top five file servers by scanned space

l A table listing:

n Number of file servers

n Volumes

n Scanned space inmegabytes

n Users - The number of users

n Users space - The amount of space inmegabytes being consumed

53



Chapter 2

To see a full-page view, access the File Servers view for the Enterprise context, as described in
Properties of the File Servers on the facing page.

Top ten extensions by size

Displays the top 10 file extensions that take up themost space in gigabytes. To see a full-page
view, access Extensions view for the Enterprise context, as described in Extension View on page
56.

Aging

Displays, in gigabytes, the size of files that have beenmodified or used within the following
periods:

l 0-30 days

l 30-60 days

l 60-90 days

l 90-180 days

l 180 days-1 year

l 1-2 years

l 2-3 years

l 3-4 years

l 4-5 years

l 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

Sizing

Displays the number of files modified within the following period:

l 0-30 days

l 30-60 days

l 60-90 days

l 90-180 days

l 180 days-1 year

l 1-2 years

l 2-3 years

l 3-4 years

l 4-5 years

l 5+ years
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For example, if two 3-GB files weremodified within the last 30 to 60 days, two would be displayed
for the 30-60 day label.

To access the dashboard:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu. The Enterprise option tells File System
Viewer to scan for all file servers on the network.

3. Select Dashboard from the Select View menu.

4. Click Go. The four panes are displayed.

To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the pane.

Properties of the File Servers
The File Servers view provides the same information as the Summary pane in the dashboard, in
addition to a table that lists all the file servers and their properties.

You can view the following information when you select the File Servers view for an Enterprise
context:

l A graph displaying the top five file servers by scanned space

l A table listing:

n Number of file servers

n Volumes

n Scanned space inmegabytes

n Users (number of users)

n Users space (amount of space being consumed)

l A table displaying the following information for each of the file servers:

n Volumes

n Scanned space

n Number of users

n Amount of space

As the file sizes grow, the units switch frommegabytes to gigabytes.

To access information about file servers:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select File Servers from the Select View menu.
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Extension View
The Extensions view for the Enterprise context provides the following information for file
extensions:

l A graph displaying the top 10 file extensions by:

n Usage – Total size of all the files with the particular extension

n Count – Number of files with the particular extension

l A table displaying the following information for each file extension:

n Usage – Total size of all the files with the particular extension

n Count – Number of files with the particular extension

To filter the information for one or more file servers, provide the name of the file extension or
provide an expression in the Filter field and then click Submit. For more information about
expressions, see Providing Expressions for the Filter Fields below.

To view information about extension groups, select Extension Group from the Filter menu or
provide an expression. Youmust create extension groups before seeing any information, see
Viewing Extension Groups on the facing page.

Data less than 1 MB is not displayed in the charts. This could result in an empty chart if all data
points are less than 1 MB.

To access the Extension view for the Enterprise context:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

Providing Expressions for the Filter Fields
File System Viewer provides filter fields throughout the various windows. Use expressions such
as the wildcard (*) to narrow your view to a particular set of items.

All of the filters work the same. For example, even though the following examples are for file
extensions, the same expressions would work for any other item you want to filter, such as file
servers.

l d* returns all extensions starting with d

l *d returns all extensions ending with d

l *d* returns all extensions with d in the extension
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Viewing Extension Groups
Create extension groups to determine how groups of file extensions are being used. For example,
to understand how much space graphic files are using and how often they are being used, you
could create a discovery group that contains file extensions for gif, png, and jpg graphic files.

After you create your extension groups, you can view the following information about them:

l A graph displaying the top 10 file extension groups by:

n Usage – Total size of all the files with the particular extension

n Count – Number of files with the particular extension

l A table displaying the following information for each extension group:

n Extensions – File extensions that make up the extension group

n Usage – Total size of all the files with the particular extension

n Count – Number of files with the particular extension

To display a reduced set of information, provide the name of the extension group or an expression
in the Filter field and then click Submit. For more information about providing expressions in the
Filter field, see Providing Expressions for the Filter Fields on previous page.

Data less than 1 MB is not displayed in the charts. This could result in an empty chart if all data
points are less than 1 MB.

Creating Extension Groups
To create an extension group:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click New Extension Group.

6. Enter a name for the extension group in theExtension Group Name field; for example,
Graphic files.

7. Enter the extensions to include in the group in the Extensions field. Separate each file
extension with a comma. For example, if you want the discovery group to track file
extensions for gif, png, and jpg files, enter the following in the Extensions field:

gif, png, and jpg

8. Click Finish.
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Editing Extension Groups
To edit a discovery group:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click Edit ( ) for the extension group you want to edit.

6. Modify the extensions that should belong to the group in the Extensions field.

7. Click Finish.

Deleting Extension Groups
To delete an extension group:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click Delete ( ) for the extension group you want to remove.

Aging View for the Enterprise Context
The Aging view provides the following information about the file servers in your environment:

l A graph displaying the size of files that weremodified or used within the following time periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years
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n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the past 30 to 60 days, 6 GB is displayed for
the 30-60 day label.

l A table displaying the number of files and their size that were accessed, modified, and created
in the specified time periods, which are the same as those listed in the graph. To view this
table, click the plus sign (+) to the left of the Show/Hide Aggregated Summary Details text.

l A table displaying, by file server, the number of files and their size in megabytes that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed,Modified, orCreated from the Age
Distributionmenu, and then click Submit.

As the file sizes grow, the units switch frommegabytes to gigabytes.

To access the Aging view:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Aging from the Select View menu. The Aging view is displayed.

Sizes View for the Enterprise Context
The Sizes view can help you understand if space on a server is being taken up by a few very large
files that are never used.

The Sizes view displays the following information:

l A graph displaying the distribution of files by usage or by count within the following size
groups:

n 0 Bytes

n 0-10 KB

n 10-100 KB

n 100 KB-1MB

n 1 10MB

n 10-100MB

n 100+ MB

l A table displaying by file server the number of files and their size that fall within the specified
size groups.

As the file sizes grow, the units switch frommegabytes to gigabytes.

To access the Sizes view:
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1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Sizes from the Select View menu. The Size view appears.

To view additional information about the files within a size group, click one of the size groups in
the graph, as shown in the following example.

The following are displayed:

l A pie chart showing the sizes of the files with the size group on each server.

l A pie chart showing the number of files with the size group on each server.

l A table showing the number of files with the size group on each server and the amount of
space they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the
data points are less than 1 MB.

To view more information about the size group on a volume, click a file server in the File Server
column in the table.

The following are displayed:

l A pie chart showing the sizes of the files with the size group on each volume

l A pie chart showing the number of files with the size group on each volume

l A table showing the number of files with the size group on each volume, the amount of space
they occupy, and the collection time

Managing Users on a File Server - Properties of Users
The Users tab enables you to see the properties of the user accounts assigned to file servers.

To access the properties:
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1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers.

l Information imported through LDAP servers. For more information about importing users
through LDAP, see Importing User Information from LDAP and Active Directory Servers on
page 28.

l Users created through the Create User tool in File System Viewer. For more information about
creating users in File System Viewer, see Adding File System Viewer Users on page 63.

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use.

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored.

n Users Size – The amount of space the users use.

n Largest User – The user who uses themost space.

n Largest User Size – The amount of space the largest user uses.

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user

n Home Directory – The home directory of the user. The home directory is assigned to a
user by the user’s organization. By default, the user has full access rights (read, write,
execute) to the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n User Status* – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n Manager* – The name of the user’s manager.

n Quota – The amount of space the user is allocated.

n Used – The amount of space the user is using.

n Instances – The number of file servers on which the user's home directory is present.
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*The User Status andManager columns are populated when the information is imported from
an LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild car, enter the full name in the
Filter box, and then click Submit.

Managing Users on a File Server - Properties of Users
The Users tab enables you to see the properties of the user accounts assigned to file servers.

To access the properties:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers.

l Information imported through LDAP servers. For more information about importing users
through LDAP, see Importing User Information from LDAP and Active Directory Servers on
page 28.

l Users created through the Create User tool in File System Viewer. For more information about
creating users in File System Viewer, see Adding File System Viewer Users on the facing
page.

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use.

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored.

n Users Size – The amount of space the users use.

n Largest User – The user who uses themost space.

n Largest User Size – The amount of space the largest user uses.

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user

n Home Directory – The home directory of the user. The home directory is assigned to a
user by the user’s organization. By default, the user has full access rights (read, write,
execute) to the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.
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n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n User Status* – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n Manager* – The name of the user’s manager.

n Quota – The amount of space the user is allocated.

n Used – The amount of space the user is using.

n Instances – The number of file servers on which the user's home directory is present.

*The User Status andManager columns are populated when the information is imported from
an LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild car, enter the full name in the
Filter box, and then click Submit.

Viewing Details for a File System Viewer User
You can view detailed information about a File System Viewer user, such as the following:

l Department

l Quota

l Total Used by Owners

l Total Used by Directories

To view details of a File System Viewer user:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Under the User ID column, click the link for the user you want to know more about.

You are shown detailed information about the user, such as the following:

l Which volumes and file servers the user is taking up space on and the amount

l Any policies assigned to the user

Adding File System Viewer Users
File System Viewer provides data about users on the file servers, including:

l The amount of space the users are using

l The user who is using themost amount of space and the amount of space being used

63



Chapter 2

It obtains information about its users from the file scans of the servers. You can also provide user
information through this tool.

This tool simulates the creation of a user account. To obtain information about users, youmust
first add them in File System Viewer. These users differ from the users for themanagement
server. When you add a File System Viewer user, you aremaking File System Viewer aware of
that user for monitoring. That user is not granted access to themanagement server.

To add a File System Viewer user

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click theNew User button located under the graph.

5. In the ID box, enter the user ID.

6. In the Name box, enter the name for the user.

Provide the domain name for users on servers runningWindows; for example,
mydomain\username. The domain name is case sensitive.

7. In the Directories box, specify a user's home directory. Home directories are assigned to
users by their organization. A user can havemultiple, comma-separated home directories.

Directory paths are case sensitive andmust be fully qualified paths. Map a user’s usage to
the home directory when configuring a file server scan.

8. In the Owners box, enter the owners that are associated with the user.

Separatemultiple owners with a comma. The owner name should be similar to what the OS
reports; for example, the domain\username onWindows.

Informationmust be entered into either the Directories box or the Owners box. Entering
information into both boxes is accepted, but not required.

9. In theDepartment Nomenu, select a department number corresponding to the department
to which the user belongs. The department number was assigned to the department when the
department was added by using Chargeback Manager

10. In the E-mail box, enter the user’s e-mail address.

11. In the Quota box, enter themaximum amount in megabytes the user can use.

Entering 0 in the Quota box grants unlimited storage capacity to the selected user.

12. Click OK.

Modifying File System Viewer Users
You canmodify the following properties for a File System Viewer:
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l Name

l Directories

l Owners

l Department Number

l E-mail

l Quota

The following procedure applies only to modifying a File System Viewer user, not a user account
for themanagement server:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. In the table below the graphic, click theEdit ( ) button corresponding to the user you want
to modify.

5. Modify one or more of the properties.

6. Click OK. The File System Viewer user is updated.

Deleting File System Viewer Users
The following steps modify a File System Viewer user, not a user account for themanagement
server. They do not affect access to themanagement server or the file server.

To delete a File System Viewer user:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Do one of the following:

n To delete one user at a time, click theDelete ( ) button corresponding to the user you
want to remove. When you are asked if you want to delete the user, click OK.

n To delete multiple users at once, select the users in the far left column and click the
Delete button located above the table. When you are asked if you want to delete the
users, click OK.
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Exporting a List of Users
After you add your users, export the list of users in case you need to reinstall themanagement
server. The user list is saved as a comma-separated values file, which can be opened in a text
editor such as Notepad. You can add to the comma-separated list as described in Modifying a List
of Users below.

To export the list of users:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click Export Users.

5. When asked if you want to save the comma-separated values file, click Save and designate
a location to save the file.

Modifying a List of Users
After you export a list of users, you can easily add to it. The attributes for each user appear on a
row for that user. The format of a user’s record is as follows:

<User ID>,<User Name>,<Home Directory(s)>,<Department>,

<E- Mail>,<Quota><Owner(s)>

Assume you have a user with the following attributes:

l User ID – JS

l User Name – John Smith

l Home Directory – Program Files

l Department – Engineering

l E-Mail – jsmith@companyname.com

l Quota – 500

l Owner – jsmith

The information for the user would appear as follows in the list:

JS,John Smith,\Program

Files,Engineering,jsmith@companyname.com,500,jsmith

A list with multiple users would appear as follows:

JS,John Smith,\Program

Files,Engineering,jsmith@companyname.com,500,jsmith

JD,John Doe,\Program Files,Engineering,jdoe@companyname.com,500,jdoe
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DD,David Double,\Program

Files,Engineering,jdouble@companyname.com,500,ddouble

The record for a user with multiple home directories would appear as follows:

JS,John

Smith,”\jsmith,\home\jsmith”,Engineering,jsmith@companyname.com,500

The record for a user with multiple owners would appear as follows:

Adm,A-

dministrator,,,netadmin@mycompany.com,,”root,bin,adm,uucp,nobody,

Administrator”

The owner can be omitted if the home directory is provided, and the home directory can be omitted
if the owner is provided.

The following boxes must be valid. Failure of any of these conditions causes themanagement
server to log that record as an error and continue to the next record:

l <User ID>

l <HomeDirectory> or <Owner>

l (Optional): <Department> – If you provide a department, the department must exist on the
management server. The department can be empty.

l (Optional): <Quota>

l Optional: <E-Mail>

Box Condition

User ID Required box. Cannot include the following:

l More than 64 characters

l Single quote (')

l Double quote (“)

l Forward slash (/)

l Back slash (\)

User Name Required box. Cannot includemore than 64 characters.

Home
Directory

Required if the owner is not specified.

List of one or more directories separated by commas, with each directory
name not more than 4000 characters.

Individual directory names should not contain commas.

Department Null or an existing department.

Restrictions for User Boxes
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Box Condition

E-Mail Null or a string of up to 253 characters.

Quota
(Megabytes)

Null or 0 to indicate unlimited, or a rational decimal number less than
9999999999999.

Value is in MBs.

Owner Required if the home directory is not specified.

List of one or more owner names separated by commas, with each
individual owner name not exceeding 256 characters.

Individual owner names should not contain commas.

Viewing Detailed Information for a User
To view the amount of space being used on a volume and other information for a user:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click theOwners tab.

The following information is displayed for the user:

l File server name

l Volume name

l Size used

l Owner

Importing a List of Users
You can import a list of users from a comma-separated values file. For information on how to add
to the current list of users in File SRM, see Exporting a List of Users on page 66 andModifying a
List of Users on page 66.

Themanagement server provides two ways to import a list of users:

l Full Import – Replaces all current users in the list with the users in the import file

l Partial Import – Updates existing users and adds new users

To import a list of users:
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1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click Import Users.

5. Click Browse to select the list of users you want import.

6. Select Full Import orPartial Import.

7. Click OK.

When you perform a partial or full import, you are provided with a report with the following
information:

l Number of records read

l Number of users created

l Number of users updated

l Number of users that could not be created

l Format errors

l Directory and owner both unspecified

l Directory already mapped to a user

l Owner already mapped to a user

l Invalid departments

l Multiple entries for users

Policies for a User
To view the policies for a user:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab. File System Viewer displays the policies assigned to the user.

Policy Manager can automatically send an e-mail, generate an event, or run a custom script when
the file server is being overused. For example, you can configure Policy Manager so you receive
an email message when the amount of free space on a file server decreases to a specified level.

Adding Policies
To add the policies for a user:
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1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Click Add in the right corner.

7. In the Name box on the Policy Properties tab, enter a name for the policy or keep the default.

8. In the Description box, modify the description for the policy or keep the default.

9. In the Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the
same actions execute. You can specify shorter periods for important applications.

10. In the Conditionmenu, specify a comparison operator.

11. To the right of the Comparison Operator menu, take the following action, depending on the
box displayed:
n Enter a percentage.

n Enter an amount in gigabytes (GB).

n Type the number of available media that will trigger an alert.

12. For trending policies, enter the number of days in the Historic period box (7 to 180 days) and
Projection period box (min=1; max=180). The Historic period is the number of days in the
past that meet the condition.

13. For trending policies, enter the number of days in the future that will meet the condition in the
Projection period box (1 day to 360 days).

14. Select an action to occur when the policy condition is fulfilled. For more information, see
“Actions Available forWhen a Policy Condition is Fulfilled” in theUser Guide.

15. Click Finish.

For more detailed information, see theManaging Policies chapter in theUser Guide.

Editing Policies
To edit a policy:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprisefrom the Select Context menu.

3. Select Usersfrom the Select View menu.

4. Click aUser IDin the User ID column.

5. Click thePolicies tab.
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6. Click theEdit ( ) button corresponding to the policy you want to modify.

7. In the Name box, change the name for the policy.

8. In the Description box, change the description for the policy.

9. Select or deselect theActive option to activate or de-activate the policy.

10. In the Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the
same actions will execute. You can specify shorter periods for important applications.

11. In the Conditionmenu, change the conditions of the policy.

12. For trending policies, change the number of days in the Historic period box (min=7; max=180)
or Projection period box (min=1; max=180).

13. Select an action to occur when the policy condition is fulfilled. For more information, see
“Actions AvailableWhen a Policy Condition is Fulfilled” in theUser Guide.

14. Click OK.

Testing Policies
To test a policy:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Click the Test button for the policy.

Deleting Policies
To delete a policy:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Do one of the following:
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n Delete just one policy – Click theDelete ( ) button corresponding to the policy you
want to delete.

n Delete several policies at once – Select the check boxes next to the policies you want
to delete. To select all of the policies, select the check box next to theName heading,
and click theDelete ( ) button.

The policies are deleted.

Viewing Security and User Identifiers for All File Servers
TheOwnership tab displays owner-related details. It enables you to determine how many files the
owner is using on the file server.

TheOwnership tab is disabled by default for file servers running onMicrosoft Windows. To view
theOwnership tab, set the fileSrm.collectWindowsSID property to true as described in Enabling
the Ownership Tab onWindows on the facing page. You can also view it by selecting the Collect
Ownership Information checkbox when configuring a file server scan.

To access the Ownership tab:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Ownership from the Select View menu.

You will see the following:

n A graph showing the top 10 owners that use themost in megabytes

n A table that lists:

o Ownership – The security identifier (Windows) or user identifier (UNIX)

o Files – The files the security identifier or user identifier uses

o Size – The total size of the files the security identifier or user identifier uses

4. To filter by owner or by expression, enter the information in the Filter field, and click Submit.
For more information, see Providing Expressions for the Filter Fields on page 56.

Viewing Detailed Information About an Owner
To view detailed information:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Ownership from the Select View menu.

4. To learnmore about an owner, click the owner’s name.

The following are displayed:
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l A pie chart showing the sizes of the files with the owner on each server

l A pie chart showing the number of files with the owner on each server

l A table showing the number of files with the owner on each server and the amount of space
they occupy

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the
data points are less than 1 MB.

Enabling the Ownership Tab on Windows
TheOwnership tab is disabled by default for file servers running onMicrosoft Windows. To view
theOwnership tab, youmust set the fileSrm.collectWindowsSID property to true.

To set the fileSrm.collectWindowsSID property to true:

1. Select Configuration > Product Health and click Advanced in the Disk Space tree.

2. Click Show Default Properties at the bottom of the page.

3. Copy the fileSrm.collectWindowsSID property.

How you copy the text depends on yourWeb browser. If you are usingMicrosoft Explorer or
Netscape Navigator, select the text, right-click the selected text, and select Copy.

4. Return to the Advanced page (Configuration > Product Health and click Advanced in the
Disk Space tree).

5. Paste the copied text into the Custom Properties box.
How you paste the text depends on yourWeb browser. If you are usingMicrosoft Explorer or
Netscape Navigator, right-click the box, and select Paste.

6. Make your changes in the Custom Properties box.

7. Change the value assigned to the fileSrm.collectWindowsSID property to true.
fileSrm.collectWindowsSID=true

8. When done, click Save.

9. Restart the AppStorManager service for your changes to take effect.

Trustee View
If you do not see information in the Trustee View, check that ACL data collection is enabled (see
Enabling the Collection of Access Control Entry Data Collection for Directories onWindows
Servers on page 45).

The Trustee view provides the following:

l A graph listing the top 10 trustees by size

l A table listing the following for each trustee:
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n Size

n Directories

To access the Trustee view:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Trustee from the Select View menu.

4. To filter the information for one or more trustees, provide the name of the trustee or provide an
expression in the Filter field and then click Submit.

For more information about expressions, see Providing Expressions for the Filter Fields on page
56.

Viewing Detailed Trustee Data
To view detailed information for a trustee, click the name of a trustee in the Trustee view. You are
then shown two pie charts:

l Size associated with the trustee inmegabytes

l Number of directories associated with the trustees

Below the pie charts is a table listing the size in megabytes and directories for each file server
associated with the trustee. The following is an example:

Here is an example of Selected Trustee Drill-down at the file server level:
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To obtain evenmore detailed information about the directories associated with the trustee, click
one of the pie charts or a file server listed in the table.

A table is provided with the following information for each directory associated with the trustee:

l Size of the current directory in megabytes

l Size of the current directory including subdirectories

l Number of trustees

l Trustee’s share

l Attributes – See Viewing Attribute Details on page 77 for more information about themeaning
behind the letters.

l Permissions – The letters in the Permissions column have the followingmeaning:

n R – Read

n W –Write

n F – Full

How Data is Calculated in the Trustee View
On themanagement server, the data is parsed to extract the effective usage by each trustee. This
is calculated by the summation of effective usage by the trustee on each directory has permission
to access. The following shows how the effective space calculations are determined for the
statistics shown in the example.
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Directory Name Full Size Own Size Trustee Rights

A 10GB 8GB X

Y

Z

F

R

–

B 18GB 12GB X

Y

Z

–

F

W

C 14GB 6GB X

Y

Z

F

F

F

Directory Statistics

The following is the effective space calculation:

l X: From A + From B + From C = (8/2) + 0 + (6/3) = 6GB

l Y: From A + From B + From C = (8/2) + (12/2) + (6/3) = 12GB

l X: From A + From B + From C = 0 + (12/2) + (6/3) = 8GB

The “own” size of a directory is considered for calculation and not the full size (which includes the
size of its subdirectories), because the subdirectories are being calculated separately anyway.

User interface screens are available to display the ACL information at various levels, including the
Enterprise level (all file servers), a selected file server, and a Volume level, for all the trustees. In
addition, drill-down is available for selected trustees at various levels.

Scan Status
The Scan Status view displays detailed information from the scans. This information is also
available from the Scan Status tab, which you can access by selectingConfiguration > File
System Viewer. For detailed information about scan status information, see Scan Status Tab on
page 26.

Scan Schedule
The Scan Schedule view displays the scheduled scans. This information is also displayed in the
Scheduled Scan tab accessible from theConfiguration > File System Viewermenu. For more
detailed information about scan schedules, see Scheduling Single andMultiple Scans on page 16.
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Viewing Attribute Details
In several of the views, attribute information is provided as a letter or several letters in the
Attribute column. The attributes have the followingmeaning.

Letter Detail

R ReadOnly

H Hidden

S System

D Directory

A Archive

V Device

N Normal

T Temporary

P Sparse File

J Reparse Point

C Compressed

O Offline

I Not Content Indexed

E Encrypted
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3 Individual File Server Details
This section consists of the following topics:

l Dashboard Information for a File Server below

l Properties for a File Server on page 81

l Finding VolumeDetails on page 82

l Type of Files on a File Server on page 83

l Aging Properties of Files on a File Server on page 86

l Size Group Distribution Information on page 87

l Users for a File Server on page 88

l Ownership Information for a File Server on page 89

l Trustee Information for a File Server on page 90

l Events for a File Server on page 90

l Viewing Topology for a File Server on page 98

l Scan Status for File Servers on page 99

l Scan Schedule for File Servers on page 100

Dashboard Information for a File Server
The dashboard displays the following information for file servers.

Summary

l A graph displays the top five volumes by usage on the file server. The amounts for free space
and used space are shown. Data less than 1MB is not displayed in the graph. This could result
in an empty graph if all data points are less than 1MB.

l A summary table to the right of the graph shows:

n Volumes – Number of volumes on the file server

n Capacity – Size of all volumes on the file server

n Used – Amount of used space on all volumes on the file server

n Free – Amount of free space on all volumes on the file server

n Used Percent – Amount of used space on all volumes on the file server

n Free Percent – Amount of free space on all volumes on the file server

n Users – Number of users assigned to one or more of the volumes on the file server

n Users Space – Amount of space the users use on the file server.
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l Top ten extensions by size displays the top 10 file extensions that take up themost space in
gigabytes.

l Aging displays the (gigabyte) size of files modified or used within the following periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the past 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l Sizing displays the number of files modified within the following period:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the past 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.
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3. Select Dashboard from the Select View menu.

4. Click Go.

To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the pane.

Properties for a File Server
To view the properties for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select Properties from the Select View menu.

The Properties page displays the following information

l Business Cost – The cost impact of the application on the network. The currency displayed
depends on the standards and formats setting on themanagement server. In the Business
Cost field, type an amount; for example, 35.25, and then click OK.

l Custom Name – A unique name for the file server. The custom name is displayed for the File
System Viewer application instead of the file server's default name. The unique name helps in
distinguishing this File System Viewer instance from the actual server. To create a unique
name, type the name in the Custom Name field and click theSave button.

l Vendor* – The vendor that created the file server

n The only symbol you can enter in front of the number is the dollar sign ($).

n You can enter a number with decimal points, such as 30.50.

l Contacted* – The last time the software contacted the file server

l Record Created* –When a record was created for the file server

l Discovery Status* – The status of the last discovery. If the element was just discovered, the
status is at “created.”

l Install Date –When the file server was installed

l Name Detected* – The name of the file server detected

l OID – TheObject Identifier

l Description* – Information about the type of element. In this instance, it would display
FileServer.

l Target Operating System* – The operating system of the file server

l IdentificationCode – The identification code of the file server

l Product Name* – The product name of the file server

l Serial Number – The serial number of the file server
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l Build Number – The build number of the file sever

l Version – The version number of the file server

l Host* – The name of the host

l Business Cost (per hour) – The business cost that was set at the top of this page

*Populated fields. By default, the rest are blank.

To update the data by doing aGet Details, click Update Element Data. Get Details could take a
while.

Finding Volume Details
To view the properties of the volumes on a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server (see Setting a Context on page 51).

3. Select Volumes from the Select View menu.

You can view additional information on volumes that have had file server collection.

This page displays the following:

l A graph that shows the top five volumes by usage on the file server, including the amounts for
free space and used space.

Data less than 1 MB is not displayed in the graph. Youmight see an empty graph if all data
points are less than 1 MB.

l A summary table to the right of the graph that shows:

n Volumes – The number of volumes on the file server

n Capacity – The size of all volumes on the file server

n Used – The amount of used space on all volumes on the file server

n Free – The amount of free space on all volumes on the file server

n Used Percent – The amount of used space on all volumes on the file server

n Free Percent – The amount of free space on all volumes on the file server

n Users – The number of users assigned to one or more of the volumes on the file server

n Users Space – The amount of space the users use on the file server

l A table below the graph that shows the volumes and the following properties:

n Capacity – The size of the volume

n Used – The amount of space used on that volume

n Used% – The percentage used on the volume
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n Users – The number of users assigned to that volume

n Users Space – The amount of space the users use

Type of Files on a File Server
The Extensions view provides information about the types of files on a file server. For example, it
can let you know how many mpgs are stored on a file server and their file size. In the extensions
tab, there is a drop-downmenu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server (see Setting a Context on page 51.

3. Select Extensions from the Select View menu. The following are displayed:

n A graph that shows the top 10 extensions and their size

n A table below the graph that shows the extension and its properties:
Size – The size of all the files with that extension. This property lets you see which types
of files are using themost space on a file server.

Count – The number of files with this extension.

4. To filter by extension, enter the extension name and click theSubmit button (see Providing
Expressions for the Filter Fields on page 56).

5. Click an extension in the Extension column in the table. You can see the following:

n A pie chart that shows the sizes of the files with the extension per volume.

n A pie chart that shows the number of files with the extension per volume.

n A table that lists the number of files with the extension per volume and the amount of
space they occupy.

Data less than 1 MB is not displayed in the graph. This could result in an empty graph if all
data points are less than 1 MB.

6. To view a listing of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N andmost aged N files with the extension are listed in the
tabs “Largest Files” and “Aged Files.” The filenamewith path, size, and the accessed,
modified, and created time are provided.

7. You can save the extensions for a volume in a comma-separated list by clicking theSave
Extension Detail button in the right pane. The extensions for that volume are saved in a
comma-separated list (CSV file).

Excel can only handle a limited number of records. If the file will not open in Excel, it may be
necessary to bring the CSV file into a database. Another option is to break the CSV file into
smaller pieces that Excel will be able to handle.
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Extension Groups

The following example shows the Extensions tab selected and the drop-downmenu choices for
selecting Extension Groups.

Select Extension Groups to display a screen showing the extension groups along with the
extensions. A screen similar to the following displays.
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You can edit or delete extension groups using the Edit or Delete icons. To create a new extension
group, select theNew Extension Group button, and a screen similar to the following is
displayed.
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You can enter the new extension group name and the extensions separated by commas. After
extension groups are created, extension group detail information appears in the Extensions tab
when the extension group is selected from the drop-downmenu.

From the volume level extension groups chart page, you can go to an intermediate page before a
final drill-down page. The intermediate page lists constituent extensions with hyperlinks to the
drill-down page to that specific extension. Here is an example.

The display lists constituent extensions with hyperlinks to the drill-down page for that specific
extension.

Filtering Files

Filters use the following expressions:

l d* returns all extensions starting with d

l *d returns all extensions ending with d

l *d* returns all extensions having d in the extension

You can enter a list of extensions separated by a comma.

Aging Properties of Files on a File Server
To find information about the aging properties of the files on a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select theAging view in the right pane.

Save the aging details to a comma-separated list (CSV file).

By default the page displays the following information:

l A graph displaying in gigabytes the size of files that have beenmodified or used within the
following time periods:
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n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB is displayed
for the 30-60 day label.

l A table displaying the number of files (and their size in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

l A table displaying, by volume, the number of files (and their size in megabytes) that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed,Modified, orCreated from the Age
Distribution since last menu, and then click Submit.

Size Group Distribution Information
To view size information for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select theSizes view.

The page displays the following:

n A bar chart displaying the size group distribution by usage or by count depending on the
option selected.

o Usage: Total size of all the files with the particular extension.

o Count: Number of files with the particular extension.

n A table listing the number of files and the total size for each size group on each volume.

4. To obtain more detailed information about a size group, click its corresponding heading in the
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table. The following are displayed:

n A pie chart showing the sizes of the files with the size group per server.

n A pie chart showing the number of files with the size group per server.

n A table showing the number of files with the size group per server and the amount of
space they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all
the data points are less than 1 MB.

5. To view a listing of the oldest files with the size group on the volume, click a volume in the
Drive column in the table.

You can save the files with the size group for a volume in a comma-separated list (CSV file) by
clickingExport Files to CVS.

Users for a File Server
To view user information for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers.

l Information imported through LDAP servers (see Importing User Information from LDAP and
Active Directory Servers on page 28).

l Users created through the Create User tool in File System Viewer (see Adding File System
Viewer Users on page 63).

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored

n Users Size – The amount of space the users use

n Largest User – The user who uses themost space

n Largest User Size – The amount of space the largest user uses

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user
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n Home Directory – The home directory of the user. The home directory is assigned to a
user by the user’s organization. By default, the user has full access rights (read, write,
execute) to the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n User Status* – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n Manager* – The name of the user’s manager

n Quota – The amount of space the user is allocated

n Used – The amount of space the user is using

n Instances – The number of file servers on which the user's home directory is present

*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild card, enter the full name in the
Filter box, and then click Submit (see Providing Expressions for the Filter Fields on page 56).

Ownership Information for a File Server
To view ownership information for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select Ownership from the Select View menu. The following are displayed for the file server:

n A graph showing the top 10 owners who use themost in megabytes (MB)

n A table showing:

o Ownership – The security identifier (Windows) or user identifier (UNIX)

o Size – The total size of the files the security identifier or user identifier uses

o Files – The files that the security identifier or user identifier uses

4. To filter by owner or by expression, enter the information in the Filter field, and click Submit.

For more information about filtering by expressions, see Providing Expressions for the Filter
Fields on page 56.
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Trustee Information for a File Server
If you do not see information in the Trustee View, check that the ACL data collection was enabled
(see Enabling the Collection of Access Control Entry Data Collection for Directories onWindows
Servers on page 45).

The Trustee view provides the following:

l A graph listing the top 10 trustees by size

l A table listing the following for each trustee:

n Size

n Directories

To access the Trustee view:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select Trustee from the Select View menu.

To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
Providing Expressions for the Filter Fields on page 56.

For information about how the trustee data is collected, see How Data is Calculated in the
Trustee View on page 75.

Events for a File Server
The Events view lists the events that involve the file server. It provides the following information
about the events for a file server.

To access the Events tab:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select theEvents view in the right pane.

Events listed on this pagemight not be attributed to the correct source until Getting Details
completes.

Setting up a Filter
Themanagement server provides several types of event filters that enable you to specify the
events you want Event Manager to display.

You can use all of the following event filters at once or just one of them:
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l Time period

l Severity level

l Element type

l Summary text

l Element name

l Cleared status

l Specific element

To set up a filter:

1. Click the Filter heading at the top of the page:

The following filtering feature is displayed:

2. Select a time from the Time Period combo box. You can also select a customized time as
described in Selecting a Custom Time Period on page 93.

3. Select which events of a severity type you want displayed. Use the Control and Shift keys to
select multiple severities. The following options are provided:
n All – Events of all severities are displayed.

n Unknown –Only events of the severity type, unknown, are displayed.

n Informational –Only events of the severity type, informational, are displayed.
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n Warning –Only events of the severity type, warning, are displayed.

n Minor –Only events of the severity type, minor, are displayed.

n Major –Only events of the severity type, major, are displayed.

n Critical –Only events of the severity type, critical, are displayed.

4. Select which events of an element type you want displayed. Use the Control and Shift keys
to select multiple severities. The following options are provided:
n All

n Application

n Host

n Switch

n Storage System

n Tape Library

n Fabric

n Other

n HP Storage Essentials

5. To set the filter by summary text, enter the text for the filter in theSummary Text Contains
field.
You can use this option when you are seeing several events that span over several elements
or severity levels. For example, to determine if someone else is logging into themanagement
server as admin, you can find how often the admin user has logged into themanagement
server over the last few days by entering the following text in theSummary Text Contains
field:
User admin logged in

6. To set the filter by element name enter text in theElement Name Contains field.
This feature can be helpful if you are interested in events from elements that have similar
names. For example, assume you have a naming convention for hosts, where all hosts that
belong to the engineering group begin with engineering. Event Managercan display only
events from those hosts when engineering is entered in theElement Name Contains field.

7. To set a filter by cleared status, select one or more of the following by using the Control and
Shift keys:
n All – All events regardless of their clear status

n All But Clear – All events except for thosemarked clear

n Clear –Only events marked clear

8. Tomerge all events together, select Collapse all events with same severity, type and
element.
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This feature is very useful when numerous events of the same severity, type, and element
are being picked up by themanagement server. If you select the optionCollapse all events
with same severity, type and element, themanagement server displays just unique events
with a total count in front of them, rather than list all of the events individually.

9. To have Event Manager filter elements automatically at a set interval, select the
Automatically filter every option and select one of the following:
n 30 seconds

n 1minute

n 5minutes

n 10minutes

10. When done setting your options, click the Filter button.

You can update the events displayed by clicking the Filter button.

Selecting a Custom Time Period
You can select a custom time period for the filter when troubleshooting an issue.

To select a custom time period:

1. Select theCustom Time Period option.

Event Manager only displays events that occur after the start date and time and before the
end date and time.

2. Click the Calendar icon to the right of theStart Date field:

3. In the Calendar, select the start date:
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4. In the Time field, enter the start time.

The time is based on a 24-hour clock. For example, to have Event Manager display events
occurring after 8 p.m. on the specified date, enter 20:00.

5. When you are done setting the start time and date, click Set.

You can set the end date and time for the filter. Event Manager only displays events that occur
after the start date and time and before the end date and time.

1. Click the Calendar icon to the right of theEnd Date field.

2. In the Calendar, select the end date:

3. In the Time field, enter the end time.
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The time is based on a 24-hour clock. For example, to have Event Manager display events
occurring before 8 p.m on the specified date, enter 20:00.

4. When done setting the end time and date, click Set.

Resetting a Filter
To revert to the default settings for the filter:

1. To access the filter for Event Manager, click the Filter heading at the top of the page:

The filtering feature is displayed:

2. Click theReset button. The filter is reset.

Setting up Advanced Filtering
Event Manager provides an advanced filtering feature that enables you to determine detailed
information for filtering.

To set up advanced filtering:

1. To access the filter for Event Manager, click the Filter heading at the top of the page:

The filtering feature is displayed:
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2. Expand theAdvanced Options heading.
Once the AdvancedOptions heading is expanded, the Element NameContains field
becomes inactive. Any values entered in the Element NameContains field are ignored while
the AdvancedOptions heading is expanded.

3. Click theAdd button:

4. Select the element type you want to add and click Next.

5. Select one or more elements you want to add to the filter andNext.
Only the elements of the type you specified in the previous window are displayed. For
example, if you selected hosts in the previous window, only hosts are displayed in this
screen.

If the element you are looking for does not appear on the first page of the table, use the
navigation tools at the top of the table to page through the list of elements.

The hosts you select are listed in the navigation filter. In the following example, Host_13081
and Host_10380 were selected for advanced filtering, so they are listed under the Advanced
Filtering heading:
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6. Verify that theAdvanced Options heading is expanded as shown in the following figure, or
advanced filtering will not work.

7. Click the Filter button.
Event Manager displays the elements specified under Advanced Options.

Clearing Advance Filtering Options
You can clear the filtering set for advanced options, by clicking theClear Data button under the
AdvancedOptions heading.

Viewing Event Details
To access event details, click the link for the event under the Summary Text column. You can
also right-click an event and select Event Details from the drop downmenu.

The Event Details pane provides information on one or more of the following:
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l Serial Number – The number assigned to the event

l Summary Text – A brief explanation of the event

l Element – The source of the event. An element can be a switch, host, application, fabric, or
anything else on the network. If this field is blank, the event did not come from an element.

l Source – If the event came from an element, the name of the element is provided.

l Time Reported – The time the event was reported to themanagement server

l Probable Cause – An explanation of a probable cause.

l Recommended Actions – Recommendations

l Event Type – Describes the event

l Correlated Indications – Information obtained from the provider

l Severity – The severity level, which can be one of the following:

n Clear

n Unknown

n Informational

n Warning

n Minor

n Major

n Critical

Sorting Events
To sort events, click the column title corresponding to the attribute you want to sort the event. For
example, to sort events by time, click the Time heading on the table on the Events tab. The
events are sorted by time on the Events page.

Viewing Topology for a File Server
To view the topology for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.
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3. Select the Topology view in the right pane.

Scan Status for File Servers
The Scan Status view displays detailed information from the scans for a file server. This
information is also available from the Scan Status tab, which you can access by selecting
Configuration > File System Viewer. You can also see information for other file servers. For
detailed information about scan status information, see Scan Status Tab on page 26.

To view the scan status for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select theScan Status view.
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Scan Schedule for File Servers
The Scan Schedule view displays the scheduled scans for a file server. This information is also
displayed in the Scheduled Scan tab accessible from theConfiguration > File System Viewer
menu. You will also see information for other file servers. For more detailed information about
scan schedules, see Scheduling Single andMultiple Scans on page 16.

To view the scan status for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 51.

3. Select theScan schedule view.
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This section consists of the following topics:

l Dashboard Information for a Volume below

l Properties for a Volume on page 103

l File System Details for a Volume on page 104

l Extensions on Volumes on page 106

l Aging Information for a Volume on page 107

l File Sizes on a Volume on page 108

l Users on a Volume on page 109

l Ownership Information for a Volume on page 110

l Trustee Information for a Volume on page 111

l Scan Status for Volumes on page 111

l Explorer View on page 111

l Directory Dashboard Details on a Volume on page 113

Dashboard Information for a Volume
The dashboard displays the following information for volumes.

Summary

l A graph is represented in one of the following ways:

n If all large directories are less than 1MB, the pie chart has only two sectors, Free and
Used.

n If there are several large directories with a size larger than 1MB, the pie chart has one
sector for Free, eight sectors for the top eight directories, and one sector for Used (Rest).

l A summary table to the right of the graph displays:

n Total Storage– The capacity of the volume.

n Used – The amount of used space on the volume.

n Free – The amount of free space on the volume.

n Scanned Space – The total size of the files that are scanned by File System Viewer.

n Capacity – The size of the volume.

n Used % – The percentage of used space on the volume.

n Free % – The percentage of free space on the volume.
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n File System – Type of the file system on the volume.

n Number of Files – Total number of files on the volume.

n Number of Directories – Total number of file on the volume.

Top ten extensions by size displays the top 10 file extensions that take up themost space in
gigabytes. To see a full-page view, access Extensions view for the Enterprise context, as
described in Extensions on Volumes on page 106.

Aging displays the (gigabyte) size of files modified or used within the following periods:

l 0-30 days

l 30-60 days

l 60-90 days

l 90-180 days

l 180 days-1 year

l 1-2 years

l 2-3 years

l 3-4 years

l 4-5 years

l 5+ year

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

Sizing displays the number of files modified within the following period:

l 0-30 days

l 30-60 days

l 60-90 days

l 90-180 days

l 180 days-1 year

l 1-2 years

l 2-3 years

l 3-4 years

l 4-5 years

l 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard:
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1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Dashboard from the Select View menu.

4. Click Go.

To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the pane.

Properties for a Volume
To view the properties for a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Properties from the Select View menu.

The Properties page displays the following information:

l Contacted* – The last time the software contacted the file server.

l File System Type* – The type of file system on the volume, such as New Technology File
System (NTFS)

l Block Size*

l Discovery Status* – The status of the last discovery. If the element was just discovered, the
status is at “created.”

l Consumable Blocks

l Number of Blocks*

l Remote Storage*

l Record Created* –When a record was created for the file server

l Device ID*

l Total Space*

l Data Organization

l Description*

l Access

l Host* – The name of the host

l Business Cost (per hour) – The business cost that was set at the top of this page

l Disk Drives* – The drive(s) associated with the volume

l Disk Partitions* – Partitions on the volume

*Populated fields. By default, the other fields are blank.
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File System Details for a Volume
To view the properties of the volumes on a file server:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select File System Info from the Select View menu.

The following are displayed.

A chart, which appears in one of the following ways:

l If all large directories are less than 1 MB, the pie chart has only two sectors: Free and Used.

l If there are several large directories with a size larger than 1 MB, the pie chart has one sector
for Free, eight sectors for the top eight directories, and one sector for Used (Rest).

To the right of the chart, a summary table displaying:

l Total Storage – The capacity of the volume

l Used – The amount of used space on the volume

l Free – The amount of free space on the volume

l Scanned Space – The total size of the files that are scanned by File System Viewer

l Capacity – The size of the volume

l Used % – The percentage of used space on the volume

l Free % – The percentage of free space on the volume

l File System – Type of the file system on the volume

l Number of Files – Total number of files on the volume

l Number of Directories – Total number of file on the volume

Below the chart, the following tabs:

l Largest Directories – Lists the largest directories on the volume first.

File System Viewer provides the following for each directory: size of the directory, number of
files in the directory, and number of subdirectories in the directory. This table lists only the files
and directories directly contained in the directory in question and not those in the
subdirectories. Click the hyperlink on the directory name to display a summary snapshot of the
directory where the Aging, Extension, Size, Largest Files, and Aged Files information is
presented.

l Largest Files – Lists the directories with the largest files on the volume first. File System
Viewer displays the name of the file, its size, and the accessed, modified, and created time.

l Aged Files – Shows information about the age of the directories on the volume, including:
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n Name of the file

n Its size

n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 77

l Largest Temp Files – Displays the largest temporary directories. File System Viewer
provides the following information:

n Name of the file

n Its size

n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 77

The time and date the file was last accessed. If the table displays information, either the
extension group TEMP does not exist orFile System Viewer could not find any temporary files.
If no TEMP extension group is found, you can create the extension group, name it TEMP, and
map all temporary file extensions.

l Duplicate Files – Displays the following duplicate file data:

n Name of file

n Size of file

n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 77

If no duplicate file data is found for the volume, one of the followingmay have occurred:

l No rule was created.

l A volumewas not mapped to the duplicate report rule.

l No duplicate file exists.
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Extensions on Volumes
The Extensions view provides information about the types of files on a volume. For example, it
can let you know how many mpgs are stored on a file volume and their file size. In the extensions
tab, there is a drop-downmenu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume (see Setting a Context on page 51).

3. Select Extensions from the Select View menu. The following are displayed:

n A graph displaying the top 10 extensions and their size. Data less than 1MB is not
displayed in the graph. This could result in an empty graph if all data points are less than 1
MB.

n A table below the graph displaying the extension and its properties:

o Size – The size of all the files with that extension. This property shows you which
types of files are using themost space on a volume.

o Count – The number of files with this extension

4. To filter by extension, enter the extension name and click theSubmit button.
See Providing Expressions for the Filter Fields on page 56 for more information.

5. To view the extension groups for a volume, select theExtension Group filter.
See Viewing Extension Groups on page 57 for more information about creating, viewing, and
removing extension groups.

6. To view a listing of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N andmost aged N files with the extension are listed in the
Largest Files and Aged Files tabs. The filenamewith path, size, and the accessed, modified,
and created time are provided.

Extensions at the File Level
To view extensions at the file level:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Extensions from the Select View menu.

4. Click an extension in the table. File System Viewer displays Largest Files and Aged Files
tabs, which provide the following information:

n File name

n Size
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n Owner

n Last accessed

n Last modified

n Created

n Attributes – See Providing Expressions for the Filter Fields on page 56.

5. To export the information to a comma, separated list, click Export files to CSV.

Excel can only handle a limited number of records. If the CSV file will not open in Excel, youmight
have to bring the CSV file into a database. Or you could break the CSV file into smaller pieces
that Excel can handle.

Aging Information for a Volume
To view aging information for a volume:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select theAging view in the right pane.

By default, the page displays the following:

l A graph that displays the size of files (in gigabytes) that weremodified or used within the
following time periods:
n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the past 30 to 60 days, 6 GB is displayed
for the 30-60 day label.

l A table displaying the number of files (and their size in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
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graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

l A table displaying, by volume, the number of files (and their size in megabytes) that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed,Modified, orCreated from the Age
Distribution since last menu and then click Submit.

Aging Properties for Individual Files
To view the aging properties for a particular file:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select theAging view in the right pane.

4. Click the heading of an age group in the table. A table appears with the following information
for the files in the age group:
n Size

n Owner

n Last accessed

n Last modified

n Created

n Attributes (see Viewing Attribute Details on page 77 for more information)

5. To save the aging details to a comma-separated list (CSV file), click Export files to CSV.

File Sizes on a Volume
To view information about file sizes on a volume:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select theSizes view in the right pane.

The page displays the following:

l A bar chart displaying the size group distribution by usage or by count depending on the option
selected:

n Usage - The total size of all the files with the particular extension

n Count - The number of files with the particular extension

l A table listing the number of files and the total size for each size group on each volume
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Individual File Sizes
To view detailed information about individual file sizes on a volume:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select theSizes view in the right pane.

4. To obtain more detailed information about a size group, click its corresponding heading in the
table.

A table is displayed showing the following information about each file in the size group:

l Size

l Owner

l Last accessed

l Last modified

l Created

l Attributes (see Viewing Attribute Details on page 77)

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the
data points are less than 1 MB.

To save the details to a comma-separated list (CSV file), click Export files to CSV.

Users on a Volume
To view information about users on a volume:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers

l Information imported through LDAP servers (see Importing User Information from LDAP and
Active Directory Servers on page 28

l Users created through the Create User tool in File System Viewer (see Adding File System
Viewer Users on page 63).

The page displays the following:
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l A graph showing the top five users by usage and the amount of space they use

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored

n Users Size – The amount of space the users use

n Largest User – The user who uses themost space

n Largest User Size – The amount of space the largest user uses

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user

n Home Directory – The home directory of the user. The home directory is assigned to a
user by the user’s organization. By default, the user has full access rights (read, write,
execute) to the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n User Status* – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n Manager* – The name of the user’s manager

n Quota – The amount of space the user is allocated

n Used– The amount of space the user is using

*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild cars, enter the full name in the
Filter box, and then click Submit. For more information, see Providing Expressions for the Filter
Fields on page 56.

Ownership Information for a Volume
To view ownership information for a volume:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Ownership from the Select View menu.

The following is displayed for the file server:
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l A graph showing the top 10 owners who use themost in megabytes (MB)

l A table displaying:

n Ownership – The security identifier (Windows) or user identifier (UNIX)

n Size – The total size of the files the security identifier or user identifier uses

n Files – The files that the security identifier or user identifier uses

To filter by owner or by expression, enter the information in the Filter field, and click Submit.

For more information about filtering by expressions, see Providing Expressions for the Filter
Fields on page 56.

Trustee Information for a Volume
The Trustee view provides the following:

l A graph listing the top 10 trustees by size

l A table listing the following for each trustee:

n Size

n Directories

To access the Trustee view:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Trustee from the Select View menu.

To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
Providing Expressions for the Filter Fields on page 56.

For information about how the trustee data is collected, see How Data is Calculated in the
Trustee View on page 75.

Scan Status for Volumes
The Scan Status view displays detailed information from the scans for a volume. This information
is also available from the Scan Status tab, which you can access by selectingConfiguration >
File System Viewer. You can also see information at the level of the file server. For detailed
information about scan status information, see Scan Status Tab on page 26.

Explorer View
The Explorer view provides the following information.

A tablewith the following information about the directories on the volume:
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l Current directory information:

n Size of the current directory in megabytes

n Number of directories in the current directory

n Number of files in the current directory

l Current directory and subdirectories information:
n Size of the current directory and its subdirectories in megabytes

n Number of directories in the current directory and its subdirectories in megabytes

n Number of files in the current directory and its subdirectories in megabytes

l When the current directory was created

l When the current directory was modified

l When the current directory was last accessed

l Attributes of the current directory (see Viewing Attribute Details on page 77)

A table listing the files at the top-level of the current directory, including:

l Size inmegabytes

l Owner

l When the file was created

l When the file was last modified

l When the file was last accessed

l Attributes of the file (see Viewing Attribute Details on page 77

OnWindows, the file owner listed for an encrypted file is the account running the CIM extension
service (usually the host's local administrator account).

To view the directory’s files and subdirectories, click the name of the directory in the first table:
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To access the Explorer view:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Explorer from the Select View menu.

Directory Dashboard Details on a Volume
To view directory dashboard details:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 51.

3. Select Explorer from the Select View menu.

4. Click theDirectory Dashboard Details link located above the first table.

File System Viewer provides the following detailed information at your fingertips in the directory
dashboard details page for files.

The Directory Dashboard provides the directory size and the number of files in the directory. This
information can be found under the name of the directory:
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When you access the Directory Dashboard, you are shown the following tabs:

l Aging – Displays the number of files and their size (in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph.

l Extensions – Displays the extension and its properties:

n Size – The size of all the files with that extension. This property lets you see which types
of files are using themost space on a volume.

n Count – The number of files with this extension.

l Sizes – Lists the number of files and the total size for each size group on each volume.

l Aged Files – Lists the following properties of a file:

n Size

n Owner

n When the file was last accessed

n When the file was last modified

n When the file was created

n Attributes. See Viewing Attribute Details on page 77 for more information.

Files are listed by age with the oldest files displayed first.

l Largest Files – Lists the following properties of a file:

n Size

n Owner

n When the file was last accessed

n When the file was last modified

n When the file was created

n Attributes. See Viewing Attribute Details on page 77 for more information.

Files are listed by size with the largest files displayed first.

l Trustee – Lists the following for each trustee:
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n Trustee’s Share

n Permissions
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